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What is MLE? What is MyProjects?  
As the name implies, the Mobile Learning Environment  (MLE) is an educational environment 
consisting of students, teachers, computers, and curriculum.  The Mobile Learning Environment 
is designed to accomplish two educational goals: Engage the students (have fun), and keep 
them Organized (stay focused).  Students working on a project in the MLE use MyProjects on 
their computers to access their project home page. 
 
MyProjects enables students to organize multiple resources on one simple screen and 
encourages students to use a variety of different learning tools— concept maps, animations, 
tables, paragraphs, slideshows and web resources—to build complex, multiform projects.  
 
MyProjects combines GoKnow!’s animation and concept mapping software with Microsoft’s 
Word and Excel, as well as a media player, PDF reader, and more. Top it all off with GoSync 
and GoManage for distributing, viewing, and grading projects, and you have a powerful learning 
tool. 
 

System Requirements  
�  Windows XP 
�  Microsoft .NET Framework 2.0 (can be downloaded from the Microsoft website) 
�  Active Ethernet connection or WiFi 802.11 (for GoSync usage) 
�  We recommend having Microsoft Office or Open Office installed, but this is not required 

(MyProjects will work with Word Pad if Office is not installed) 
 
��� �  NOTE: MyProjects will work with other applications such as Adobe Reader and Google Earth. 
If these programs are installed on the computer, the icons will appear in MyProjects, but these 
programs are not required. 
 
 

Getting Started – Logging In  
Each student has their own unique MyProjects username and password. These are created the 
first time they open MyProjects on their computer.  
 
��� �  NOTE: If you are using MyProjects with GoManage in your classroom, be sure to use the 
same username in MyProjects and GoManage.  
 
To start MyProjects, click the Start  menu �  Programs  �  GoKnow! MyProjects . 

1. If this is the first time MyProjects is being used on the computer: 
a. Enter a username you would like to use (for instance, your first and last name 

together -- e.g. AbeLincoln) 
b. Click “Log In” (Figure 1, next page) 
c. MyProjects asks you to enter a password. This is the password you will use to 

log into MyProjects from now on 
d. Create your password, type it in and click “OK” 
e. MyProjects asks you to re-enter your password 
f. Re-enter your password, then click “OK.” This launches MyProjects. 

 
��� �  NOTE: If you don’t want to use a password, leave the password field blank and click “OK” 
twice. 
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Figure 1  

 

2. If this is NOT the first time MyProjects is being used on the computer: 
a. Select your username from the combo box (Figure 1, above) 
b. Type in your password and click “OK” 
c. This launches MyProjects 

 

��� �  NOTE: If you do not see your user name in this box, you need to create a new one. Click 
<New User>, type your username in (for instance, your first and last name together -- e.g. 
AbeLincoln), click “Log In,” create a password, click “OK,” re-enter the password. Click “OK.” 
 

Creating a New Project  
Once you have logged in with your username and password, you will see a Recent Projects 
screen that lists the most recent projects you have worked on (Figure 2). If you have never 
created a project, there will be nothing listed here! 
 

 
Figure 2  

 
To create a new project, click “New Project.” A window appears. Give your project a name and 
click “Create.” Welcome to the main MyProjects screen (Figure 3, next page). 
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Figure 3  

 

The large yellow area on the left side of the screen is the canvas or blueprint. The area on the 
right side of your screen is the Resources bar, or toolbox, which contains a list of applications. 
The applications listed here may vary depending on what is installed on the computer. 
 

Opening a Saved Project & Deleting a Project  
If you have already created a project, you can open it when you first log in to MyProjects. Select 
the project you wish to open from the list, and click “Open” (Figure 2, previous page). 
 

��� �  NOTE: If your project is not listed on the recent projects screen, click “More Projects.” This 
lists all the projects you have available. Click the one you would like to open, then click “Open.” 
 

To delete a project when you first log in to MyProjects, click “Delete” from the bottom of the 
recent project screen. When you click “Delete,” you will bring up a list of projects on your 
computer (Figure 4). Click on the project you wish to delete, and click “Delete.” You will be 
asked if you are sure you want to delete this project. Click “Yes.” 
 

 
Figure 4 

 

If you are currently working on a project, and wish to delete the active project, click “Delete” 
from the file menu. A window appears, asking you if you really want to delete this project. Click 
“Yes.” You will return to the Recent Projects screen. 

 

WARNING! Deleting a project also deletes all the files that are associated with it. For example, 
if you have a Sketchy resource on your MyProjects canvas, and you delete the project, you will 
be deleting the project file and the Sketchy file! If the project hasn’t been synchronized using 
GoSync, the file can’t be recovered.  Be careful with this. 
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Saving a Project under Another Name  
1. To save a project under another name, open that project and click “Save Project As” 

from the file menu. 
 

2. Type a new name for the project, then click “Save.” 
 

Exiting MyProjects  
1. If you have just logged into MyProjects, click “Exit” from the Recent Projects screen. 

 

2. If you are currently working on a project, click “Exit” from the file menu or click the ‘X’ in 
the top right corner of the window. Your work is automatically saved. 

 

Resources  
Once you have created a new project or opened an existing project, you will see your canvas 
and resource bar. The resource bar features all of the programs and tools that MyProjects 
offers.  To see all of the resources, use the arrows to navigate through the list.  
 

��� �  NOTE: As previously mentioned, the applications available within MyProjects will depend on 
which applications are installed on the computer. 
 

These resources include:  

  Microsoft Word 

  Microsoft Excel 

  Internet Explorer 

  PiCoMap 

  
Sketchy 

  PowerPoint 

   Adobe Reader
 

  Media Player 

  Paint 

  Calculator 

  
GoSync 

  
Available disk space 

  
Remaining battery power 
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Using resources  
To use any of the resources, simply click on the icon in the resource bar. You will be prompted 
to name your resource. Enter a name and click “Create” (Figure 5).  
 

 
Figure 5 

 

��� �  NOTE: If you leave the box next to “Open resource after create” checked, the resource will 
open automatically once you click “Create.” If you uncheck the box, a tile for the resource will be 
placed in MyProjects, but the resource will not open until you click on that tile. 
 

Moving To and From Project View  
The ease of moving to and from the MyProjects canvas is one of the things that makes it so 
powerful. It takes just one click to work on your resource and one or two clicks to get back to 
your canvas:  

1. To return to MyProjects, simply click the  button in the upper-right hand corner.  
 

2. Your work is saved automatically in Sketchy and PiCoMap.  
 

3. In some applications, such as Word and Excel, when you click the  button to return to 
MyProjects, you will be prompted to save the changes you made to the document. Click 
“Yes” to save the changes. 

 

To access a resource from your project canvas, simply double-click on it. 
 

Moving, Renaming and Deleting resources on the Canv as 
Moving a resource  
You may move a resource anywhere on the canvas once it has been created. To move your 
resource, simply drag the icon to the desired location on the canvas.  
 

Renaming your resource  
To rename your resource, right-click on the resource you wish to edit. A drop-down menu 
appears (Figure 6). Click “Rename.” You will be prompted to enter a new name for your 
resource. When you are done, click “Rename.”  

 

 
Figure 6 

Deleting a resource  
��� �  Warning:  Deleting a resource also deletes the file that is associated with it. For example, if 
you have a Sketchy resource on your canvas, and you delete the resource, you will also be 
deleting the Sketchy file itself. If your project hasn’t been synchronized using GoSync, the file 
can’t be recovered. Be careful, please! 

 

To delete a resource, right click on the resource to bring up the context menu (Figure 6, above). 
Click “Delete”. Click “Yes” at the warning prompt. 
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Importing a Resource  
Whenever you create a resource in a project, you will notice an option that says “Import” next to 
the “Create” button in the “New Resource” window (Figure 7). This allows you to import existing 
resources into your project. If you already have the perfect file on your computer that you want 
to include in MyProjects, importing is the way to go. 
 

 
Figure 7  

 
To import a resource: 
 

1. In order to import a resource, you must first create the same type of resource as the one 
you wish to import. For example, if you wish to import a PiCoMap, you must first create a 
PiCoMap in MyProjects, then click “Import” in the “New Resource” window. 

 
2. When you click “Import,” you will see a list of all the resources of that type that have 

been created. For example, if you created a PiCoMap resource and clicked “Import,” you 
would see a list of all of the PiCoMaps currently on the computer. These PiCoMaps 
would be grouped by project. 
 

3. Select the resource you wish to import and click “Import” (Figure 8). 
 

 
Figure 8  

 
 

��� �  NOTE:  MyProjects defaults to automatically opening the new resource. To place the 
resource on the canvas without immediately going to it, un-check the checkbox next to “Open 
resource after create” prior to clicking Import in step 2. 
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Brief Overview of Each Resource  

PiCoMap   
PiCoMap is a tool that enables students to create concept maps. 
 

Creating a PiCoMap resource 
 

To create a PiCoMap resource, click from the resource bar. Give the resource a name, 
then click “Create”. You arrive at a new PiCoMap canvas. 
 
There are two main elements that are used when creating concept maps – concepts and links. 
A concept is an idea that is contained in a single shape. A link is a line connecting two concepts. 
To create a new concept, draw an oval (hold down your left mouse button while you draw the 
shape) on the PiCoMap canvas (Figure 9) – it doesn’t have to be a perfect shape! This shape is 
often referred to as a “node.” 
 

 
Figure 9 

 

When you release your mouse button, you will be taken to a “Create Concept” window (Figure 
10).  

 
Figure 10 

 

Enter the name of your concept in the box next to “Name.” You can change the color of your 
node by clicking the arrow next to the color in the “Color” box and clicking on the desired color.  
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If you wish to add notes to your concept, you can type in the “Notes” box. This can be useful if 
you want to add supporting details. For example, if your main concept was the name of an 
important leader, you could include dates of rule, birthday, or other important information in the 
notes section. 
 
��� �  Note: Notes will not show up on the main concept map. However, the node will be shaded in 
gray to indicate that there are notes. 
 
When you have finished creating your concept, click “Ok” to return to the main PiCoMap 
canvas.  
 
Your new concept node will appear (Figure 11).  
 

 
Figure 11 

 
Repeat this process to create as many nodes as you desire. As shown in Figure 12, nodes that 
contain additional notes are shaded in gray. 
 

 
Figure 12 
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Moving resources and navigating the canvas 
 

To move your concept to a different location on the screen, simply click and hold your left 
mouse button inside the shape and drag your mouse to move the shape across the screen. 
Release the mouse button at the desired location. 
 

��� �  NOTE: The scroll bar on the right side of the screen allows you to move your nodes further 
apart as needed. 
 

Creating links 
 

Once you have created two or more concepts, you can draw links to connect them. To draw a 
link, simply use your mouse to draw a line from the middle of one concept to the middle of 
another (Figure 13).  
 

 
Figure 13 

 

A “Create Link” box will appear (Figure 14). 
 

 
Figure 14  
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In the box next to “Name,” you can enter text to describe the relationship between two concepts, 
or you can leave it blank. Notice that below the name box, there is text starting with “Do you 
mean” (Figure 14, previous page). This text indicates the directionality of the relationship. 
 

For example, if you created a link between the words “speed” and “acceleration,” and added the 
text “is an increase in” in the name box, the “Do you mean” section would say “Do you mean: 
speed is an increase in acceleration?” Since you probably meant to say that acceleration is an 
increase in speed, click the “Reverse” button to change the directionality of the relationship. 
 

You can also add notes to a link, just like with a concept. For example, if you link two people 
who were married, the notes section would be a good place to add the date of their wedding. 
 

When you are finished, click “Ok.” You will return to the main PiCoMap screen. As you can see, 
a link is drawn between the concepts with the text you entered and an arrow indicating 
directionality (Figure 15). If you entered notes, the text box would be shaded in gray. If you left 
the name box blank, you would only see the arrow, no text. 
 

 
Figure 15 

 

Editing concepts and links 
 

To edit a concept simply click on the concept to open the “Edit Concept” window (Figure 16). 
Make your changes, then click “Ok.” 
 

 
Figure 16 

To edit a link, click the link to open the “Edit Link” window. As with editing concepts, make your 
changes, then click “Ok.” 
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Deleting concepts and links 
To delete a link, follow the same steps you used to edit a link (click on the link to bring up the 
“Edit Link” window). Then, instead of making changes and clicking “Ok,” simply click “Delete” 
instead (Figure 17). 
 

 
Figure 17 

 
To delete a concept, simply draw a diagonal line through it on the main PiCoMap canvas 
(Figure 18). 
 

 
Figure 18 

 
A confirmation window will pop up. Click “Yes” to delete the concept. 
 
��� �  NOTE: If you delete a concept that is linked to another concept, you will also delete the link. 
However, if you only delete a link, the concepts will not be deleted. 
 

As with any resource, when you are finished creating your PiCoMap, click the  in the top right 
corner of the screen to return to the main MyProjects canvas. PiCoMap saves your work 
automatically when you close it. 
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Sketchy   
Sketchy is a drawing and animation tool. Students create animations using freehand and 
geometric shapes. Animations can be 999 frames long, and helpful features such as duplicate 
frame and insert frame enable efficient and easy animation creation. Teachers use Sketchy to 
have students animate processes, relationships and concepts such as cell development and 
plant growth. 
 

Creating a Sketchy resource 
 

To create a Sketchy resource, click  from the resource bar. Give the resource a name, 
then click “Create”. You arrive at a new Sketchy canvas. 
 

Basic Sketchy tools 
 

When you first open Sketchy, you will see a blank canvas with a number of menus and icons 
across the top of the screen and on the left side (Figure 19). These icons are the tools available 
in Sketchy. We’ll start with the File menu and go through everything from left to right and top to 
bottom. More information about using the tools is in the “Using the tools” section a bit later. 
 

 
Figure 19 

 

1. File 
·  If you click on the file menu, you will have the option to return to the main 

MyProjects canvas. You can also click on the  in the top right corner of the 
screen to return to your main canvas. 

2. Edit 
·  If you click on the edit menu, you will see the options to undo, import image, cut, 

copy, paste, and select all. These tools are useful for copying and moving things 
from one frame to another or duplicating things on a single frame. For example, 
you could use the select tool to select a shape, then use copy and paste to paste 
that same shape in another part of the frame. The “import image” feature will be 
discussed in more detail later. 
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3. Frame 
·  Clicking on the frame menu pulls up the options to insert before, insert after, 

duplicate, clear, and delete. The insert before and insert after options allow you 
to insert a blank frame either before or after the one you are currently viewing. 
This is useful if you get to the end of an animation and realize you need an extra 
frame in the middle! The duplicate, clear, and delete options do the same as the 
icons at the bottom of the icon bar. These will also be explained in more detail 
later. 

4. Drawing tools  
·  If you click on the pencil icon, you will see a popup menu with a variety of 

drawing tools (Figure 20). 

 
Figure 20 

·  These tools are: 

    Pencil tool for freehand drawing 

  Eraser 

   Select tool (for selecting areas of a picture) 

  Straight line tool 

  Ribbon drawing tool 

  Text tool for inputting text 

   Filled-in square 

   Filled-in circle 

   Square outline 

  Circle outline 

   Color selector tool 

5. Color palate  
·  If you click on the color palate, you will see a popup menu containing a number 

of different colors (Figure 21).  Click on any of these colors prior to using another 
tool to change the color of the shape/line/text/etc. Click “More” for more colors. 

 
Figure 21 
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6. Pen size tool  
·  If you click on the pen size tool, you will see a popup menu with several options 

(Figure 22). You can click on one of the lines to change the thickness of the line 
drawn using the pencil or straight line tools. This will also change the size of the 
eraser. Make your selection prior to using another tool. 

 
Figure 22 

7. Play animation  
·  The film reel icon is how you play an animation once it has been created. Click 

on it once to play the animation – the green play icon will turn to a red square. 
Click on film reel icon again to stop the animation. You can also pause an 
animation while it is playing by clicking the pause button (it will appear only when 
the animation is playing). However, you need to stop the animation fully before 
continuing to work on your Sketchy. 

8. Frame navigation  
·  The frame navigation lets you know what frame you are on. When you create a 

new frame, the number will increase. You can use the arrows to go back and 
forth between frames.  

9. New frame tool  
·  If you click on the new frame tool, you will create a new, blank frame. You will 

see that the frame number increases and you will automatically be taken to the 
new frame. 

10. Duplicate frame tool  
·  For making animations, the duplicate frame tool is one of the most important 

tools available. If you click on this duplicate frame icon, you will duplicate the 
frame you were on. You will see that the frame number increases by 1. After 
duplicating a frame, you could move something on the 2nd frame, duplicate that 
frame, and continue that process for several more frames. When you play the 
animation, you will see movement! 

11. Clear screen  
·  The page with the paintbrush icon is how you clear a screen. You must be on the 

frame you wish to clear, then click this icon. Anything that has been drawn in that 
frame will be erased. This doesn’t delete the actual frame – it only clears the 
contents. 

12. Delete entire frame  
·  The small recycling bin icon is how you delete an entire frame. Navigate to the 

frame you wish to delete, then click the recycle icon. The frame will be deleted. If 
there were frames after the one you deleted, you will be taken to the next frame 
of the series. IMPORTANT: you will not be asked to confirm that you want to 
delete a frame, so be careful! 
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13. Cut  
·  When you select something using the “select” tool, you can cut it to move it to 

another location or a different frame. 

14. Copy  
·  As with the “cut” tool, once you have selected something, you can use the “copy” 

tool to duplicate it. 

15. Paste  
·  Whenever you have cut or copied something, use the paste tool to place it in the 

new location. 

16. Undo  
·  If you click on the undo tool, you will undo the last step of whatever you did (i.e. 

the last shape you drew). This tool will only undo ONE step, so if you make a 
mistake, you should use the undo tool right away! 

 

Using the tools 
 

To draw, simply select a tool from the Tool menu and draw on the screen! Certain tools function 
slightly differently than others, so here is some additional information: 
 

1. Using the text tool 
·  First, choose the color you want your text to be from the color menu. Then, select 

the text tool from the drawing tools. 
·  Click on the screen to position your cursor. 
·  A box will appear with a space for you to enter text. Type your desired text. 
·  You can use the drop-down menu under “size” to change the size of the font. 
·  When you have finished typing, be sure to click somewhere else on the screen to 

make the text permanent. 
 

��� �  NOTE: You can only type a limited number of characters in one line. If you would like to enter 
more text, simply click in another position after you finish your first line. 
 
��� �  NOTE: Once you have entered text and clicked somewhere else on the screen, you can no 
longer edit the text. If you made a mistake, you can erase what you wrote and type it again. 
 

2. Using the select tool 

·  Choose the select tool from the drawing tools menu  
·  Use your mouse to drag a box around the region you want to select. The easiest 

way to do this is to put your cursor in the top left corner of where you want the 
selection box to begin, then hold down the left mouse button and drag to the 
bottom right corner of where you want the box to end. 

·  Release the mouse button when you have created the box. 
·  To move the selected area, click in the middle and drag it to a new location. If 

you don’t like where you moved it, click “undo” before you go on to another step! 
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3. Using the shapes (square or circle) 
·  To create a shape, first select the desired color from the color palate on the tool 

bar. Then, select the shape from the drawing tools menu. 
·  Move your cursor to the desired location on the screen, hold down the left mouse 

button, then drag your mouse until the shape is the size you want. 
 

Importing an image in Sketchy 
Under the “Edit” menu, there is an option that says “Import Image.” Clicking on this option will 
bring up an “Import” window. This window will list all the image files on your Computer. You can 
select one of these images to import into your Sketchy. Simply click on the file name, then click 
“Import.” The image will appear in the top right corner of your Sketchy. While it is still selected 
with the dotted box, you can drag the image to the desired location on the frame. 
 

If you do not have any image files on your computer, your list in the Import window will be blank. 
You can use GoManage to send images to your Computer (see the GoManage user guide). 
 

��� �  NOTE: when saving images on your Computer or on your desktop to be sent to your 
Computer, save them as a .jpg file, not a .bmp file. This helps reduce the file size so as not to 
take up unnecessary amounts of memory on your computer. 
 

Creating an animation in Sketchy 
 

To create an animation in Sketchy, you must first create multiple frames (like you were creating 
a flipbook). Below is an example of a simple Sketchy illustrating one circle orbiting around 
another (Figure 23). As you can see, the frame number increases every time the smaller circle 
is moved. This was accomplished by duplicating the frame, then selecting the small circle, 
moving it slightly, duplicating the new frame, and repeating the process. 
 

 
Figure 23 

When you are finished creating your Sketchy, click the  in the top right corner of the screen to 
return to the main MyProjects canvas. Sketchy saves your work automatically when you close it. 
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Microsoft Word   
Within MyProjects, you can create and import Word documents. The Word icon will only appear 
in MyProjects if you have Microsoft Word installed on your computer. MyProjects is compatible 
with both Microsoft Word 2003 and 2007. If you do not have Microsoft Word installed, 
MyProjects will open Word Pad as a default. MyProjects is also compatible with Open Office, so 
you can use the Open Office word processor within MyProjects. 
 

Creating a Word resource 
 

To create a Word resource, click  from the resource bar. Give the resource a name, then 
click “Create.” You arrive at a new Word document.  
 

Basic Word features 
 

When you first open Word, you will arrive at a blank screen (Figure 24). You can start typing 
right away, or you can use some of the options to change formatting, layout, etc. 
 

 
Figure 24 

 
Across the top of the screen, you will see a number of menus and icons. These menus and 
icons allow you to format your text. You can change the font, the alignment of the text, and the 
indentations. You can also insert pictures, date and time stamps, etc. Some of the key features 
of Word are listed below. 
 
��� �  NOTE: if your toolbars are different from those pictured, you can right-click on a blank area 
next to a toolbar and choose which toolbars you want to display. The most common toolbars are 
the standard and formatting toolbars. 



   
 
 

Copyright 2008, GoKnow! Inc.    Last Updated:     Page 19 
All rights reserved.     9/3/08 

 
 
 

Formatting options 
 

Font formatting 
Drop-down menus allow you to change the font, as well as the size and the color. Simply click 
on the arrow to the right of the item you wish to change to see the options (Figure 25). 

 

 
Figure 25 

 
In addition, you have the following options: 

    Bold  

    Italic 

     Underline 

 
Layout options 

    Align text left 

    Center text 

    Align text right 

   Numbered list 

   Bulleted list 

   Shift item right 

   Shift item left 
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Spell check 
 

Clicking the spell check button  brings up a window that will display spelling and grammar 
errors (Figure 26). You can also access the spell check feature under the “Tools” menu at the 
top of the screen. 
 

 
Figure 26 

 

Track changes 
 

A useful feature in Microsoft Word is the track changes feature. This feature allows you to see 
what changes have been made to a document. Students can use this when editing their work. 
They can also use the comment feature to make notes on a document. To access the track 
changes feature, click on the “Tools” menu at the top of the screen, then click on “Track 
Changes” (Figure 27). 
 

��� �  NOTE: if you can’t see the “Track Changes” option on the tools menu, you may need to click 
the down arrow on the menu to see more options. 

 

 
Figure 27  
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When “track changes” is turned on, an extra toolbar will appear with more options (Figure 28) 
 

 
Figure 28  

 

Once you have turned on track changes, any additions, deletions, or comments you make to the 
original document will be displayed (Figure 29). Teachers can use this feature to comment on 
student work, and students can use the feature to annotate documents. 

 

 
Figure 29  

 

Exiting Word and saving your work 
 

When you have finished using Word, click the  in the top right corner of the screen. You will 
be prompted to save your work (Figure 30).  
 

 
Figure 30 

 

Click “Yes” to save your work. 
Click “No” if you do not want to save your work. 
Click “Cancel” to return to the document you were working on 
 

��� �  WARNING: If you click “No,” you will lose any changes you made to the document! 
 
��� �  NOTE: For more information on using Word, consult software guides provided by Microsoft. 
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Microsoft Excel   
 

Within MyProjects, you can also create and import Excel spreadsheets. The Excel icon will only 
appear in MyProjects if you have Microsoft Excel installed on your computer. MyProjects is 
compatible with both Microsoft Excel 2003 and 2007. MyProjects is also compatible with Open 
Office, so you can use the Open Office spreadsheet application within MyProjects. 
 

Creating an Excel resource 
 

To create an Excel resource, click  from the resource bar. Give the resource a name, then 
click “Create”. You arrive at a new Excel spreadsheet. 
 

Basic Excel features 
 

When you first open Excel, you will arrive at a blank screen (Figure 31).  
 

 
Figure 31 

 
You will see rows and columns forming cells where you can enter information. Simply click in a 
cell and begin typing! When you are done entering information in a cell, click somewhere else to 
make the entry permanent. 
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Formatting options 
 

Across the top of the Excel screen, there are a number of menus and formatting options (Figure 
32).  
 

 
Figure 32  

 

��� �  NOTE: If you do not see the formatting toolbar, right click on an open area next to a toolbar. 
Make sure both “standard” and “formatting” toolbars are selected. 
  
Font formatting 
Drop-down menus allow you to change the font, as well as the size and the color. Simply click 
on the arrow to the right of the item you wish to change to see the options (Figure 33). 

 

 
Figure 33 

 

Similar to Word, you have the following options: 

    Bold  

    Italic 

     Underline 
 

Layout options Additional options 

    Align text left 

    Center text 

    Align text right 

   Merge cells 

     Format cell as currency 

     Format cell as percent 

     Decrease indent 

   Format borders 

   Fill color 

   Font color 
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Making a chart or graph 
 

Excel is a powerful tool for graphing data. You can make bar graphs, line graphs, and more! 
 

To make a graph, first enter your data in the spreadsheet. Select the cells that contain the data 
you want to include in the graph. Click on “Insert” at the top of the screen, and select “Chart.” A 
chart wizard window will appear (Figure 34). 
 

 
Figure 34 

 

Under the “Chart type” tab, select the type of chart you want to create. Click “Next.” 
 

Under “data range,” make changes to what data is included. Under the “series” tab, you can 
change the axis labels. Click “Next.” 
 

Under “Chart Options,” you can make changes to your chart by adding a title, changing the 
gridlines, etc. When you have finished making your changes, click “Next.” 
 

The final step of the wizard is the “Chart Location” window (Figure 35). Select where you would 
like your chart to appear. If you choose the “as new sheet” option, Excel will place the chart on a 
blank sheet in your workbook. If you choose “as object in,” Excel will place the chart on an 
existing sheet. The default setting will place the chart in the sheet that contains your data. 
 

 
Figure 35 
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When you have selected the location for your chart, click “Finish.” Your chart will appear in your 
chosen location. You can resize your chart by dragging the boxes that appear around the chart 
(Figure 36). You can also use the chart toolbar to make changes to your chart. 
 

 
Figure 36 

 

When you have finished using Excel, click the  in the top right corner of the screen. You will 
be prompted to save your work (Figure 37).  

 

 
Figure 37 

 
Click “Yes” to save your work. 
Click “No” if you do not want to save your work. 
Click “Cancel” to return to the spreadsheet you were working on 
 
��� �  WARNING: If you click “No,” you will lose any changes you made to the document! 
 
��� �  NOTE: For more information on using Excel, consult software guides provided by Microsoft. 
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Microsoft PowerPoint   
 

Within MyProjects, you can create and import PowerPoint Presentations. As with the other 
Microsoft Office applications, the PowerPoint icon will only appear in MyProjects if you have 
Microsoft PowerPoint installed on your computer. MyProjects is compatible with both Microsoft 
PowerPoint 2003 and 2007. MyProjects is also compatible with Open Office, so you can use the 
Open Office presentation application within MyProjects. 
 

Creating a PowerPoint resource 
 

To create a PowerPoint resource, click  from the resource bar. Give the resource a name, 
then click “Create”. You arrive at a new PowerPoint presentation. 
 

Basic PowerPoint features 
 

When you first open PowerPoint, you will arrive at a blank slide template (Figure 38).  
 

 
Figure 38 

 
The first slide has a spot for a title and subtitle. Simply click inside the textbox for either the title 
or subtitle and enter your desired text. 
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Formatting options 
 

As with the other Microsoft Office applications, across the top of the PowerPoint screen, there 
are a number of menus and formatting options (Figure 39).  
 

 
Figure 39  

 

��� �  NOTE: If you do not see the formatting toolbar, right click on an open area next to a toolbar. 
Make sure both “standard” and “formatting” toolbars are selected. 
  
Font formatting 
Drop-down menus allow you to change the font, as well as the size and the color. Simply click 
on the arrow to the right of the item you wish to change to see the options (Figure 40). 

 

 
Figure 40 

 

Similar to Word, you have the following options: 

    Bold  

    Italic 

     Underline 
 

Layout options Additional options 

    Align text left 

    Center text 

    Align text right 

   Numbered list 

   Bulleted list 

   Increase font size 

   Shift item right 

   Shift item left 

 

Slide options 

       Change slide design 

     Insert new slide 
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Creating a presentation 
 

PowerPoint has many options available for creating presentations with colors, graphics, 
animations, etc. However, creating a basic presentation is very simple. On the first slide, enter a 

title and subtitle if desired. Then, add a new slide by clicking the  button on the 
toolbar at the top of the screen. On the second slide, add whatever content you would like to 

display. Click  again, and repeat the process until you have created the desired 
number of slides. 
 

Inserting graphics 
To insert graphics into your presentation (such as clip art, photographs, charts, or WordArt), 
click on the “Insert” menu at the top of the screen. From that menu, you can choose what you 
would like to insert into your presentation (Figure 41). 
 

 
Figure 41 

 

Adding animation 
In PowerPoint, you can animate different parts of your presentation. For example, you can have 
text scroll across the screen or have an image rotate into position. To animate a part of your 
presentation, click on the “Slide Show” menu at the top of the screen. Under the “Slide Show” 
menu, click on “Custom Animation” (Figure 42). 
 

 
Figure 42 

 

An animation sidebar will appear. Click on the text box or object you wish to animate. Click “Add 
Effect” in the animation sidebar (Figure 43, next page). Select your effect from the list of options. 
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Figure 43 

 

Viewing your slide show 
When you have finished creating your presentation, you can view it as a slide show. To view the 
side show, click on the “Slide Show” menu at the top of the screen, then click “View Show” 
(Figure 44). Alternatively, just hit F5 on your keyboard. Click your mouse button to advance 
through the slides. To return to the editing view, hit the ESC key on your keyboard at any time. 
 

 
Figure 44 

 

When you have finished using PowerPoint, click the  in the top right corner of the screen. 
You will be prompted to save your work (Figure 45).  

 

 
Figure 45 

 

Click “Yes” to save your work. 
Click “No” if you do not want to save your work. 
Click “Cancel” to return to the spreadsheet you were working on 
 

��� �  WARNING: If you click “No,” you will lose any changes you made to the document! 
 

��� �  NOTE: For more information on using PowerPoint, consult software guides provided by 
Microsoft. 
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Internet Explorer    

 
Internet Explorer is an internet browser similar to internet browsers found on most computers. 
To use Internet Explorer on the computer, you must first be connected to the internet. For 
information about connecting to the internet, talk to your network administrator or IT support 
staff. 
 

Creating an Internet Explorer resource 
 

To create an Internet Explorer resource, click from the resource bar. Give the resource a 

name, then click “Create.” 
 
You arrive at a screen that details how to add a web page resource to your project (Figure 46). 
 

 
Figure 46 

 
Using Internet Explorer 

 
To access a website, type in the URL address of the web page you would like to go to or select 
the web page from your Favorites. 
 
Once you have navigated to the desired website, you are able to save the link or save the page 
for offline viewing. 
 
��� �  NOTE:  If you save the link only, you will need to have an internet connection to view the 
resource again while saving for offline viewing will create a snapshot of the site on your 
Computer. 
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Saving websites 
 

To save a website, first navigate to that site, then click on the “File” menu at the top of the 
screen. Choose “Save to Current Project.” A “Save to MyProjects” window will appear (Figure 
47). Choose either “Save Online Link Only” or “Save for Offline Viewing.” Then, click “Save.”  

 

 
Figure 47 

 
When the saving process is complete, you will see some statistics about the site.  Click on 
“Return to MyProjects” and you will be returned to your project, with your web page saved as a 
resource. 
 
��� �  NOTE: For more information on using Internet Explorer, consult the software guides that 
came with your Computer or guides published by Microsoft. 
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Paint   
Paint is a drawing tool used to create simple images. Unlike Sketchy, you cannot create 
animations using Paint. 
 

Creating a Paint resource 
 

To create a Paint resource, click  from the resource bar. Give the resource a name, then 
click “Create.” You arrive at a blank Paint screen (Figure 48). 
 

 
Figure 48 

 
Basic Paint Tools 

 
On the right of the screen are basic drawing tools (Figure 48, above). The functions of these 
tools are listed on the next page. At the bottom of the screen are the colors. Pick a color prior to 
using any of the other tools. 
 

��� �  NOTE: If you double click on one of the colors, you will bring up an “Edit Colors” window. 
This will allow you to create custom colors to use in your drawing.
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These tools are: 

    Free-form select tool 

    Eraser 

    Color picker 

    Pencil 

    Airbrush 

    Straight line 

    Rectangle 

    Oval 

    Select tool 

    Paint bucket (fill with color) 

    Magnifier (zoom) 

    Paint brush 

    Text tool 

    Curve 

    Polygon 

    Rounded rectangle 

 

To return to your project once you have completed your Paint drawing, click  in the upper-
right hand corner.  If you have made any changes to your Paint resource, you will be prompted 
to save your work (Figure 49). 
 

 
Figure 49 

 
 
Click “Yes” to save your changes, click “no” if you do not want to save your changes. Click 
“cancel” to continue working in Paint.  
 
��� �  NOTE: For more information on using Paint, consult the software guides that came with your 
computer. 
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Adobe Acrobat Reader    
Adobe Acrobat Reader is an application that allows you to read PDF files. You can use this 
application to read eBooks as well as other PDF documents. 
 

��� �  NOTE: Acrobat Reader will not allow you to create or edit PDF files – you can only view 
them. 
 

��� �  NOTE: When choosing an eBook to read using Acrobat Reader, be sure that it is in PDF 
format. Acrobat Reader will not open other formats such as .lit files. 
 

Creating an Acrobat Reader resource 
 

To create an Acrobat Reader resource, click  from the resource bar. Click “Import.” Locate 
the file you’d like to use from the list of available files and click “Import.” 
 

 
Figure 50 

 

The PDF will open (Figure 51). You can use the arrows at the top of the screen to navigate 
through the pages of the PDF. You can also use the scroll bar on the right. 
 

 
Figure 51 
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Media Player   
Media Player can play back movies and audio on your computer. 
 

Creating a Media Player resource 
 

To create a Media Player resource, click  from the resource bar. Click “Import.” Locate the 
fire you’d like to use and click “Import.” 
 
Use Media Player to view the movie (Figure 52). 
 

 
Figure 52 

 

To return to your project once you have completed viewing your Media Player movie, click  in 
the upper-right hand corner.  
 
��� �  NOTE: For more information on using Media Player, consult the software guides that came 
with your computer. 
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Calculator  
The calculator is useful for performing calculations, ranging from simple arithmetic to more 
complex scientific computations. 
 

��� �  NOTE: the calculator does not save your work when exiting. Please make sure to copy down 
any important information before closing the calculator. 
 

Creating a Calculator resource 
 

To create a calculator resource, click  from the resource bar. Give your resource a name. 
Click “Create.” The calculator will open (Figure 53). 
 

 
Figure 53 

 
You can use the basic functions of the calculator to perform calculations. To use the calculator 
in scientific mode, click on the “View” menu at the top of the calculator, then click “Scientific” 
(Figure 54).  
 

 
Figure 54 

 

To return to your project once you have completed using the calculator, click  in the upper-
right hand corner.  
 
REMEMBER: calculator does not save! 
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GoSync   

GoSync, combined with GoManage, the classroom manager, is an easy and effective way to 
manage a classroom’s, or even a school’s data. It can store projects from each computer, and 
can be used to distribute assignments, grades, or even new applications. The best part is, you 
can use GoSync directly from MyProjects. 
 
��� �  NOTE: Prior to using GoSync, you must have an active internet connection (wireless or 
wired). In addition, you must have set up your sync settings. For more information on changing 
your settings, see the GoManage user guide. 
 

Syncing with GoManage 
 

1. Click the  icon at the bottom of the resource bar. 

 
2. A GoSync window appears (Figure 55). 

 

 
Figure 55 

 
3. Make sure you see a message saying “Network Up.” 

 
4. Click “Sync.” 
 
5. GoSync synchronizes your data with the GoManage server. 

 

6. To return to your project, click  in the top right corner of the GoSync window. 
 
��� �  NOTE: For more information on using GoSync and GoManage, see the GoManage user 
guide. 
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Additional Features  
 
 

Available disk space    

To check available disk space, click  from the bottom of the resource bar. A window will 
appear telling you the amount of disk space available (Figure 56). Click “Ok” to return to your 
project. 
 

 
Figure 56  

 

Remaining battery power   
 

To check remaining battery power, click  from the bottom of the resource bar. A window will 
appear telling you the current batter power (Figure 57). Click “Ok” to return to your project. 
 

 
Figure 57 

 
 

 
 
 
 
 
 
 

 
 

Additional Support  
 

Additional support and user information can be found at http://www.goknow.com/Support/. 
 
If you have any questions or concerns, please contact: support@goknow.com. 


